# Introduction to Web Content Management with Collage

Peter Mosinski
Supervisor of Web Services
CSU Channel Islands

rev. date: November 20, 2009

## Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login to Collage</td>
<td>2</td>
</tr>
<tr>
<td>Change Your Collage Password</td>
<td>5</td>
</tr>
<tr>
<td>Configuring Associated Applications</td>
<td>6</td>
</tr>
<tr>
<td>Creating a new web page in Collage</td>
<td>9</td>
</tr>
<tr>
<td>Creation Process outline</td>
<td>9</td>
</tr>
<tr>
<td>Step-by-Step Process for Creating a New Document</td>
<td>10</td>
</tr>
<tr>
<td>Approving Your Document</td>
<td>18</td>
</tr>
<tr>
<td>Editing an Existing Web Page</td>
<td>19</td>
</tr>
<tr>
<td>Summary of Editing Tools</td>
<td>21</td>
</tr>
<tr>
<td>Applying Heading and Paragraph Styles</td>
<td>22</td>
</tr>
<tr>
<td>About the Use of Styles</td>
<td>22</td>
</tr>
<tr>
<td>Rules for applying “Heading” styles in Collage</td>
<td>22</td>
</tr>
<tr>
<td>Example of Correctly Applied Heading and Paragraph styles</td>
<td>23</td>
</tr>
<tr>
<td>How to apply Heading and Paragraph styling</td>
<td>24</td>
</tr>
<tr>
<td>How to add emphasis within a paragraph</td>
<td>25</td>
</tr>
<tr>
<td>Examples of bad and good paragraph formatting</td>
<td>25</td>
</tr>
<tr>
<td>Remove formatting from text</td>
<td>26</td>
</tr>
<tr>
<td>Insert an Image into your Web Page</td>
<td>26</td>
</tr>
<tr>
<td>Creating Links using the Link Tool</td>
<td>32</td>
</tr>
<tr>
<td>Create an internal hyperlink (to another web page)</td>
<td>32</td>
</tr>
<tr>
<td>Create an internal hyperlink (to a non-HTML document, such as PDF or MS Office documents)</td>
<td>34</td>
</tr>
<tr>
<td>Create an external hyperlink</td>
<td>38</td>
</tr>
<tr>
<td>Create a link to an Email Address</td>
<td>40</td>
</tr>
<tr>
<td>Uploading Files to Collage (Contribution view)</td>
<td>41</td>
</tr>
<tr>
<td>Replacing Single Files in Collage (Contribution view)</td>
<td>45</td>
</tr>
<tr>
<td>Creating Lists</td>
<td>47</td>
</tr>
<tr>
<td>Create a Bulleted List</td>
<td>47</td>
</tr>
<tr>
<td>Create a Numbered List</td>
<td>49</td>
</tr>
<tr>
<td>Removing Bullets and/or Numbered Lists</td>
<td>49</td>
</tr>
<tr>
<td>Indenting Bulleted or Numbered Lists</td>
<td>50</td>
</tr>
<tr>
<td>Tips &amp; Procedures for Complex Bulleted or Numbered Lists</td>
<td>53</td>
</tr>
<tr>
<td>Creating Tables in Collage</td>
<td>54</td>
</tr>
<tr>
<td>Example Table and Procedure</td>
<td>54</td>
</tr>
<tr>
<td>Changing Table Properties</td>
<td>58</td>
</tr>
<tr>
<td>Copying and Pasting from Microsoft Word into Collage</td>
<td>59</td>
</tr>
<tr>
<td>Option 1. Word &gt; Notepad &gt; Collage (recommended)</td>
<td>59</td>
</tr>
<tr>
<td>Option 2. Word &gt; Dreamweaver &gt; Collage</td>
<td>59</td>
</tr>
<tr>
<td>Technical Support and Assistance</td>
<td>60</td>
</tr>
<tr>
<td>Running Collage for the First Time</td>
<td>60</td>
</tr>
</tbody>
</table>
Login to Collage

   a. Please use Internet Explorer 6.0 or 7.0 or Firefox 1.5.x on Windows computers.
   b. Please use Firefox 1.5.x only on Mac computers.
2. Enter your provided user name and password and press the “Login” button.
   a. Your user name and password will be provided to you by Web Services.
   b. If you forgot your user name or password, please contact the Help Desk at helpdesk@csuci.edu
3. Next, select the project you wish to log in to from the provided list, and click “OK”.
   a. Choose “Website” to log into the CSUCI web site project.

4. Once you have logged in successfully, you will see the contents of the Home tab in Collage.
5. Notice the five “tabs” pictured in the screenshot below. As a content contributor, you will typically only see two tabs: the **Home** tab and the **Content** tab.
Change Your Collage Password

1. Select the “Preferences” icon in the top right-hand corner of the Collage workspace.

![Preferences icon](image1)

2. In the window that appears, select the “User” icon in the left-hand column.

![User Preferences window](image2)

3. Next, enter your old password in the “Old Password” text box.
4. Enter your new password in the “New Password” and “Confirm Password” text boxes.
5. Click the “Update” button.
6. Your new password is now in effect.
Configuring Associated Applications

By default, Collage knows what programs to use to edit certain types of files. You can also configure what applications to use to view or edit specific file types.

1. To begin, click the “Preferences” icon in the top right-hand corner of the Collage workspace.

2. In the window that appears, select the “Content Editors” icon in the left-hand column.
3. Next, select the Asset type you would like to associate to an editor. In the below example, we will associate Adobe Acrobat Documents with the Adobe Acrobat application; so in this case, click on “Adobe Acrobat Document”
4. You have several options in this dialog:
   a. Set Type to “Default Application” to enable your computer to use the default application for viewing and editing as defined by your computer’s operating system. This is the default setting.
   b. Set Type to “User Defined” to select a different application to open a particular file type.
   c. Set Type to “Internal” to use Collage’s built-in web page editor (this is only available for certain document types, such as HTML and other text-based documents).

5. If you set the Type to “User Defined”, click the “Browse” button and choose the software on your computer which you wish to use to view and/or edit that specific document type.
   d. Here are some common, default paths to popular applications. Note that these may vary from computer to computer.
   e. Microsoft Word 2003
      i. C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE
   f. Microsoft Excel 2003
      i. C:\Program Files\Microsoft Office\OFFICE11\EXCEL.EXE
   g. Microsoft PowerPoint 2003
      i. C:\Program Files\Microsoft Office\OFFICE11\POWERPNT.EXE
   h. Adobe Acrobat 6.0 Professional
      i. C:\Program Files\Adobe\Acrobat 6.0\Acrobat\Acrobat.exe
   i. Adobe Photoshop 7.0
      i. C:\Program Files\Adobe\Photoshop 7.0\Photoshop.exe

6. Click the “Apply” button to finish, and click the “Close” button to exit this dialog.
Creating a new web page in Collage

Creation Process outline

An outline of creating a new web page is as follows:

1. Browse to the folder where you want to create your new web page
2. Create the new web page
3. Enter the headline and the body text, either by typing or by using copy-and-paste from Windows Notepad.
4. Format the body text as necessary, using “style” formatting to create a document structure
5. Save the file & Exit the editing window.
6. Preview the file
7. Approve the file
8. The file is automatically deployed to the production web server
Step-by-Step Process for Creating a New Document

1. Log in to Collage as described above (http://collage.csuci.edu).
2. Click on the “Content” tab at the top of the screen.
3. Next, make sure “Contribution” is displayed in the Subview drop-down. If not, click on the Subview menu and select “Contribution” from the drop-down menu which appears.
4. Browse to the folder where you want to create your new document.
   a. Click on the “www.csuci.edu” folder name or Beta folder icon.
b. Next, click on the folder name for your area. You may need to click on a few folders to get to this location. This information can be provided to you by Web Services.

5. Click the “New Document” icon to create a new page in the folder.
6. In the dialog box which appears, fill in the following information
   a. **Document Type**: from the dropdown menu, choose the correct document type for the content that you are creating.
      i. For example, Human Resources would use the “HR_Level1” template
      ii. If you are unsure of what template to use, please contact the Help Desk at helpdesk@csuci.edu or call 805-437-8552.
   b. **Name**: the file name of the web page. This will be the name of the page as it appears in the URL to your web site.
      i. For example “aboutus” would be the page name for a page called “About Us”. The URL to the “About Us” web page might then be http://www.csuci.edu/myprogram/aboutus.htm
      ii. *Do not use spaces or special characters* when creating the document name; however, you may use dashes or underscores in the “Name” field as desired.
      iii. **Note about Home Pages**: if this new page is going to be a web site home page, enter “index” in the Name field. “index” is a special file name that is reserved specifically for home pages.
   c. **Description (optional)**: Type in a short, descriptive title for the web page.
      i. Due to a Collage bug, the Description field cannot contain apostrophes or special characters.
      ii. It is perfectly acceptable to leave the Description field blank. This field is not commonly in use, but may be used for configuring site navigation in the future.

 ![New Document Dialog Box](Serena_Collage_-_Web_Page_Dialog.png)

8. Enter the **Page Title**/headline
   a. Click in the box that reads “**Page Title Goes Here**” and type in the title of the page.
   The formatting for the page title/headline will be set automatically.
9. Enter the Body Text
   a. Click in the box that reads “Body text goes here” and enter the body text for the page.
   b. To copy and paste into this editable text area, first copy-and-paste your content into Windows Notepad or another plain-text editor before you copy-and-paste into Collage. This will help you maintain correct paragraph and style formatting.

c. To remove any extraneous formatting resulting from copy-and-paste:
   i. Highlight the text in the body text section of the document
   ii. Click on the “Clear Formatting” button on the bottom-right corner of the window.

10. Next, click on the “Exit” button to save your changes and to exit.
11. Next, you should **preview** your new file in Collage to ensure that the text and layout appear as they should.

   a. In the “Contribution” folders view, locate the document that you just created.

   b. Next, check the checkbox next to the name of the file.

   c. Then select the “**Preview**” icon on the Collage toolbar.
12. This preview will show you how your document will actually appear when it has been published to a production web server, such as www.csuci.edu. Hint: if it looks incorrect here, it will look incorrect when it is published to the web site.
**Approving Your Document**

You must “approve” your file before Collage understands that it is ready to be posted to the production web server. This allows you to work on your file and make successive changes without having them be posted.

1. When you are ready for your page to “go live”, do the following:
   b. Click on the icon on the far right-hand side of the row that contains your document (as shown below):

   ![Image of the file list with an approval icon highlighted]

2. You will see a dialog box appear which reads “Asset approved”. Click OK to finish.

   ![Image of the approval dialog box]

   c. The blue “approval” icon will then disappear; this signals Collage that the file is ready to be placed on the production web server

3. **Congratulations!** Your file has now been created and approved, and will be published automatically to the “live” web server at a regular scheduled interval.
**Editing an Existing Web Page**

1. Login to Collage as previously described
2. Next, browse to the folder in Collage which contains your web site.
3. Check the checkbox next to the file that you wish to edit

4. Choose the “Edit” icon from the Collage toolbar.

5. Collage’s built-in web page editor will open your content for editing in a new window as shown:

6. You can now edit your page.
7. Notice that at the top of your window you have a full set of HTML editing tools at your disposal. These tools function in the same way as they would in a word processor, like Microsoft Word.
   a. A summary of the use of these editing tools is provided later in this document.
   b. Editing icons that are grayed out are unavailable for a given field or document type.

8. When you are finished editing the page, click the “Exit” icon on the editing toolbar.

9. A window will prompt you to decide whether to save your last changes or not
   a. Click “Yes” to save your last changes and exit
   b. Click “No” to discard your last changes and exit
   c. Click “Cancel” to return to the editing window.
**Summary of Editing Tools**

Here is a brief synopsis of each icon's use from the Collage Help Files followed by specific comments. Please note that not all tools will be available for all documents.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spell</td>
<td>📚</td>
<td>Checks the spelling in the current field, and suggests corrections or alternates if any are available.</td>
</tr>
<tr>
<td>Bold</td>
<td>⚪</td>
<td>Bolds selected text, if it is allowed for the current field.</td>
</tr>
<tr>
<td>Italic</td>
<td>🍃</td>
<td>Italicizes selected text, if it is allowed for the current field.</td>
</tr>
<tr>
<td>Underline</td>
<td>🤔</td>
<td>Underlines selected text, if it is allowed for the current field.</td>
</tr>
<tr>
<td>Alignment</td>
<td>📚</td>
<td>Aligns selected text to the left, right, or center. Web designers determine whether or not you can apply alignment formats to text in different contribution fields.</td>
</tr>
<tr>
<td>Indent</td>
<td>📚</td>
<td>Indents the current paragraph, if it is allowed for the current field.</td>
</tr>
<tr>
<td>Outdent</td>
<td>📚</td>
<td>Removes indents for the current paragraph, if this is allowed for the current field.</td>
</tr>
<tr>
<td>Image</td>
<td>📚</td>
<td>Enables you to browse for and insert an image to the selected point in the text, if this is allowed for the current field.</td>
</tr>
<tr>
<td>Link</td>
<td>📚</td>
<td>Enables you to define and insert an HTML link to the selected point in the text, or to convert selected text into an HTML link, if this is allowed for the current field.</td>
</tr>
<tr>
<td>Table</td>
<td>📚</td>
<td>Enables you to define and insert a table to the selected point in the text, if it is allowed for the current field. You can also select an existing table and modify it. You can define the number of rows and columns, the width of each column, the width of borders, cell padding, and cell spacing.</td>
</tr>
<tr>
<td>List</td>
<td>📚</td>
<td>Converts the current selection to a list item (bulleted or numbered), if this is allowed for the current field.</td>
</tr>
<tr>
<td>Anchor</td>
<td>📚</td>
<td>Enables you to insert an HTML anchor in text fields in which anchors are permitted.</td>
</tr>
<tr>
<td>Style</td>
<td>📚</td>
<td>Applies a pre-defined style to the current paragraph or heading, such as cascading style sheet styles. The styles that contributors can apply are defined by web designers in the document definition file. Clicking this button displays a list of all possible styles.</td>
</tr>
<tr>
<td>Content</td>
<td>📚</td>
<td>Inserts a pre-defined, reusable content snippet. Web designers define the available snippets in the contribution document file. Clicking this button displays a list of all available snippets. This is very useful for inserting content that is commonly reused, such as copyright statements or contact information.</td>
</tr>
<tr>
<td>Form</td>
<td>📚</td>
<td>Enables you to insert or edit an HTML form.</td>
</tr>
</tbody>
</table>
Applying Heading and Paragraph Styles

About the Use of Styles

The “Style” tool is use to format text according to preset font color, size, style and weight criteria to any given paragraph; a “style” always applies to an entire paragraph.

Most importantly, the use of style applies structure to your web content that improves both usability and accessibility when done correctly.

Collage is configured to use pre-defined “styles” as defined by the CSUCI web style sheet to present a consistent graphic standard for formatting paragraphs, headings, and sub-headings.

Rules for applying “Heading” styles in Collage

Special usability rules apply for the use of “Heading” styles, as follows

1. Heading styles must always be applied in numerical descending order according to the reading order of the page.
   - Example #1: you should never apply “Heading 3” style to any paragraph before a “Heading 2” style is used somewhere prior in the page.
   - Example #2: you should never skip a heading style, such as applying “Heading 4” to any paragraph before applying Heading 1, Heading 2 and Heading 3 to text earlier in your page.
2. It is perfectly acceptable to use the same heading style more than once, as long as it is in the correct order.
   - For example, you can use Heading 1 once, then three Heading 2’s.
3. It is perfectly acceptable to use a previously used same heading style more than once, as long as it is in the correct order.
   - For example, you can use Heading 1 once, then three Heading 2’s, then Heading 1 again.
4. Do not use under any circumstances use bold and/or italics as a means of creating a content heading. Use only the predefined styles and the “Style” button to create page headings.
Example of Correctly Applied Heading and Paragraph styles

About Us

Heading 1


Heading 2 (subheading of Heading 1)


Heading 2 (subheading of Heading 1)


Heading 3 (subheading of Heading 2)

Heading 4 (subheading of Heading 3)


Heading 1

Heading 2

Morbi nunc urna, tempus malesuada, gravida non, elementum eu, enim. Aenean ullamcorper magna in risi. Praesent odio quam, hendrerit sodales.
How to apply Heading and Paragraph styling

1. In the “body text” box of a Collage document, highlight a paragraph of text:

   Heading 3 (subheading of Heading 2)
   Heading 4 (subheading of Heading 3)

   Paragraph formatting looks like this. Quisque a sem eget tellis
dolor. Aenean ullamcorper sapien eget massa. Vestibulum tincidunt
malesuada, gravida non, elementum eu, enim.

   Heading 1
   Heading 2

2. Select the “Style” button on the editing toolbar

3. From the dropdown menu which appears, choose one of the following styles:
   a. Normal: used for paragraph text, including tables & lists
   b. Heading 1: typically not used; used in page title bar only
   c. Heading 2: body text major sub-headings
   d. Headings 3 through 6: body text minor sub-headings
How to add emphasis within a paragraph

Frequently you may need to add emphasis to pieces of content within a web page. Use the following guidelines to help you determine how to judiciously add emphasis to certain words, phrases or sentences throughout a web page:

1. Use the “Bold” or “Italic” icons on the editing toolbar to judiciously add emphasis to key words, phrases or sentences in a paragraph.
2. Use “Bold” or “Italic” to apply emphasis to an entire paragraph only once or twice per page; rarely use “Bold” or “Italic” on two paragraphs in a row.
3. Feel free to use “Bold” or “Italic” to add emphasis to single words or short phrases throughout your page.
4. Never use “Bold” or “Italic” to create the appearance of a page heading.
5. Never use “Underline” to apply emphasis in Collage. The “Underline” icon is disabled in Collage because that HTML attribute is deprecated due to accessibility and usability issues.
6. Font style and size changes disabled in the standard editing interface, because they are typically discouraged.

Examples of bad and good paragraph formatting

<table>
<thead>
<tr>
<th>Bad:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Good:</th>
</tr>
</thead>
</table>
Remove formatting from text

To remove incorrect formatting (such as colored link text), highlight the text and use the “Clear Formatting” link at the bottom right corner of the screen.

This feature works inconsistently. Sometimes it’s easier to remove the paragraph and text altogether and to re-type it.

Insert an Image into your Web Page

Before you insert an image, please make sure that the image has been resized to the correct pixel dimensions for web display. It is not recommended to upload original digital photos or scanned images into Collage that have not been optimized for web display. Resizing of images and web display optimization is typically done using a photo editing application such as Adobe Photoshop.

To insert an image into your document:

1. In the editing window, place your cursor where you would like the image to be inserted.

2. Next, click on the “Image” icon in the editing toolbar.
3. When you click on the **Image** icon, the “Insert Image” dialog will appear:
4. **If the image that you want to add already exists in Collage:**
   a. In the list of folders in the left-hand column, click on the **name** of the folder where the existing image is stored in Collage. This will show you the list of images in that folder in the right-hand column.

   ![Folder and Images List]

   b. Check the checkbox next to the image you wish to use. The result will look like this:

   ![Selected Image]

   ![Image Selection Result]
5. If you want to add a new image into your page (and into Collage):
   a. First, in the left-hand column, click on the “images” folder within your web folder. In the example shown below, notice that the “images” folder resides within the “it” folder in Collage.

   ![Image Folder Example]

   b. Then, Click on the “New Image…” button:
c. Once the “New Image” button is clicked, the “Add file” dialog window will appear. Select the image you wish to upload from your computer, and click the “Open” button.
  - Once you click the “Open” button, it may take up to 1 minute to refresh the display while your image is uploaded into Collage, depending on the size of the image.

d. The image will then be uploaded to the website in the folder chosen. From here the image is treated as an existing one as described in the previous steps.
6. Finally, type in a short (80 characters or less) text description for any meaningful images (to meet University accessibility requirements) in the “Alt” text field as shown below.
   a. NOTE: when “Alt” is left blank, image will be marked as a decorative image within the page code.

7. To finish placement of the image, click the “OK” button.
8. Your image will then appear in your web page.
Creating Links using the Link Tool

The “Link” tool allows you to:

1. Create a hyperlink to another document already within Collage (an **internal** link)
2. Create a hyperlink to a web page outside of **www.csuci.edu** (an **external** link)
3. Create a link to a section in the current page (an anchor link in the current page)

Items #1 and #2 will be discussed in this introductory guide.

Create an internal hyperlink (to another web page)

1. Type in the name of link. In this example, we will create a link to the Information Technology home page.

2. Then, highlight the text you wish to make into a link

3. Click on the “Link” icon on the editing toolbar and this dialog box will open.

![Insert Link - Web Page Dialog](image)

Name: **Information Technology**

Target: **Current window**
4. Click on “Internal” tab to view files and folders within Collage.
5. In the left-hand column, click the “+” icon next to the “Website” folder.
6. In the left-hand column, click on the “+” icon next to the “www.csuci.edu” folder.
7. In the left-hand column, browse to the folder which contains the file that you would like to link to, in this case, the Information Technology home page, called “index” and located in the /it folder.

8. Click the “OK” button to create the link.

9. An internal link has been created. The hyperlink will appear as underlined text as seen here.
Create an internal hyperlink (to a non-HTML document, such as PDF or MS Office documents)

In general, it’s best to present content on your web site as web pages. However, sometimes you will need to post a PDF file, Word document or other Microsoft Office document. This process will show you how to correctly create a link to a PDF file or a Microsoft Office document.

1. Create your PDF file or Microsoft Office document on your computer.

2. Upload the document to Collage (see the Uploading Files to Collage section in this guide.)
   a. Typically, you will upload your Word and PDF files to the “documents” folder within your organization’s web space in Collage.

3. Once you upload the file, write down the file size of the uploaded Word or PDF document as displayed in Collage. You can view the file size in the main Collage window. You will need this for a later step.

4. Open up a web page for editing.

5. In the web page, type in the name of link.
   a. In this example, we will create a link to the CSUCI Web Accessibility Checklist, which is a MS Word document.

6. Then, highlight the text you wish to make into a link.
7. Click on the "Link" icon on the editing toolbar and the Link dialog box will open.

8. Click on "Internal" tab to view files and folders within Collage.
9. In the left-hand column, browse to the folder which contains the file to which you wish to link.
   i. HINT: this will likely be in the "documents" folder within your Collage web space.
10. In the **Title** field, enter the text description of the link. This descriptive text is typically the same as the text in the “Text” field. Click the “OK” button to finish creating the link.

11. An internal link has been created. The hyperlink will appear as underlined text as seen here.

12. You’re almost done. To satisfy Section 508 accessibility requirements, you must also place a link to the software which is required to read your Word document or PDF file on your web page.

13. Position your cursor after the newly created link, and add a space.
14. Click on the “Content” button on the editing toolbar. (You may need to expand the editing window to see this button).

15. From the drop-down list, choose the content that is appropriate to the link you are creating
   a. For PDF documents, choose “PDF doc type”
   b. For MS Word documents, choose “MS Word doc type”
   c. For Excel spreadsheets, choose “MS Excel doc type”

16. This will automatically insert a link to the appropriate software reader for the specified file type

   Links
   - CSUCI Home Page
   - Web Accessibility Checklist (MS Word, xxKB)

17. Finally, replace the “XX” in the default text to the file size that you wrote down earlier in this process. You may use the abbreviations KB for kilobytes or MB for megabytes.

   Links
   - CSUCI Home Page
   - Web Accessibility Checklist (MS Word, 102KB)

18. You have now created an accessible, usable link to a MS Word document.
Create an external hyperlink

1. For this example, we will create a link to the local weather forecast for Camarillo, using the following link to Weather.com: http://www.weather.com/weather/local/93012?from=mycity_wx

2. First, type in the link text on your page, such as “Local Weather Forecast”. Once you have typed in the link text, highlight it.

3. Next, click on the “Link” icon on the editing toolbar and this dialog box will open.
4. Make sure the “External” tab is selected in the “Insert Link” window. If not, click on the “External” tab to view the contents of the tab.

5. First, check to see if a link to the site already exists. Scroll through the list to see if that link already exists. Links are organized in alphabetical order. If it does, simply check the checkbox next to it, and click “OK” to complete the link.

6. If the link does not already exist, click on the “New Link” button. A new window will appear:

7. In the “Name” text box, give your link a descriptive name, such as “Weather.com Local Weather Link”

8. In the “URL” text box, type in the web address (URL) to the web site you want to link to.

9. Click “OK” when finished.
10. Wait for the list of links to reload. In the “**Name**” field, you will see the name of your link displayed.

11. The link will now be displayed in your page.

**Create a link to an Email Address**

The Collage editor will automatically create an email link out of any email address that you type in the editing window. Simply type in the email address anywhere in the editing window.
Uploading Files to Collage (Contribution view)

This procedure will allow you to upload Word documents, images, and PDF files into the Collage environment. You will need to upload these kinds of files into Collage before you can create links in your web pages to these documents.

1. Log in to Collage.
2. Click on the “Content” tab and select the “Contribution” view.
3. In Collage, open the folder in which you wish to upload your new document.
   a. In this example, we will upload a Word document called “**Web Accessibility Checklist**” to the Web Services folder, located in the /www.csuci.edu/it/web/documents/ folder.
   b. You should see the contents of the folder you wish to upload to in the right-hand column.

4. Select the “**Upload**” button on the Collage toolbar.
5. The “Upload File” dialog box will appear. Select the “Browse…” button.

6. The “Choose file” dialog box will then appear. Browse your computer to choose the location of the document that you wish to upload (from your Desktop or elsewhere on your computer). One you have highlighted the file, click “Open”.
7. Next, click the “OK” button to begin the file upload.

8. Depending on the size of the file(s) that you are uploading, this can take several minutes. Once the file is uploaded, the file must be added to the Collage database. This happens automatically, but it may take 1-2 minutes. You will know the process is done once the asset appears in the folder you selected AND the Size attribute of the file does NOT read “0.00kb”.

9. Once upload is complete, you will see the file displayed in the folder you selected.

10. Notice that a newly uploaded file creates an unapproved version of the file. You **must approve the file before it will be published to live**. Please refer to the section “Approving Your Document” in this guide
Replacing Single Files in Collage (Contribution view)

At times, you may need to replace a document within Collage with a more recent version, while preserving all links within Collage to that document. The following procedure describes how to replace a single file in Collage.

1. Log in to Collage.
2. Click on the “Content” tab and select the “Contribution” view.
3. In Collage, go to the folder that you wish to replace a given document; in this example, we will replace the “Web Accessibility Checklist” with a newer version.

4. Check the checkmark next to the file that you wish to replace with your new document.
5. Select the “Upload” button on the Collage Toolbar.

6. The “Upload new copy of these assets” dialog box will appear. Select the “Browse...” button, and choose the location of the new files on your Desktop (or elsewhere on your computer).

7. One you have highlighted the file, click the “Open” button.

8. Next, add a “Check in comment” to the Check-in Comment text field to explain why you are replacing this file. This comment will become part of the version history for this document.

9. Click the “OK” button to begin the file upload.

10. Depending on the size of the file(s) that you are uploading, this can take several minutes. Once the file is uploaded, the file must be added to the Collage database. This happens automatically, but it may take 1-2 minutes. You will know the process is done once the asset appears in the folder you selected AND the Size attribute of the file does NOT read “0.00kb”.

11. Once upload is complete, you will see the file displayed in the folder you selected.

12. Notice that a newly uploaded file creates an unapproved version of the file. You must approve the file before it will be published to live. Please refer to the section “Approving Your Document” in this guide.
Creating Lists

The “List” tool creates bulleted and numbered lists. Lists are important for organizing items into logical groups, and are the correct way of creating “chunks” of content that make for easy-reading web pages.

Create a Bulleted List

1. First, type out your list. You must separate your list items using paragraph breaks (i.e., by pressing the “Enter” key on your keyboard at the end of each item). If you use line breaks, ordered and bulleted lists will not be created correctly.

2. Highlight the items that you wish to convert into bullet points.

3. Next, choose the “List” icon on in the editing tool bar.
4. A drop-down menu will appear:

5. Choose a list type
   a. Choose “type Disc” for a bulleted list
   b. Alternately, you can choose one of the other bullet types (listed under the “Unordered” heading) if desired.

6. A bulleted list of the selected type will then be created from the highlighted text.
Create a Numbered List

1. Follow steps 1 to 3 as previously described in this section for “Creating a Bulleted List”
2. From the drop-down menu which appears, choose one of the Ordered list options:
   a. Choose “**type 1**” for a numbered list using standard numerals (1, 2, 3…)
   b. Choose “**type a**” for a numbered list using lower-case letters (a, b, c…)
   c. Choose “**type A**” for a numbered list using upper-case letters (A, B, C…)
   d. Choose “**type i**” for a numbered list using lower-case roman numerals (i, ii, iii…)
   e. Choose “**type I**” for a numbered list using upper-case roman numerals (I, II, III…)
3. A numbered list of the selected type will then be created from the highlighted text.
Removing Bullets and/or Numbered Lists

1. Highlight the text in the bulleted or numbered list.

2. Press the “Outdent” button on the editing toolbar until the bulleted list or numbered list disappears.

3. The bullets or numbered list then reverts to a set of paragraphs.
Indenting Bulleted or Numbered Lists

1. Create your bulleted list, skipping the indented items.

2. Position your cursor at the beginning of the line you wish to indent.

3. A new indented item will be placed on the line BELOW the previous list item.

4. Replace the placeholder text with actual list item text

5. To add additional items to the indented list, position your cursor at the end of the list item, and press the “Enter” key on your keyboard to add additional bulleted or numbered items
6. To select a different numbering scheme for an indented section of a list:
   a. Click anywhere within the indented list

   1. List Item 1
   2. List Item 2
   3. List Item 3
     - List Item 3a
     - List Item 3b
   4. List Item 4
   5. List Item 5

   2. List Item 2
   3. List Item 3
     - List Item 3a
     - List Item 3b
     - List Item 3c
     - List Item 3d
   4. List Item 4
   5. List Item 5
b. Click the “**List**” button, and choose the desired numbering or bullet type.

![List button with options](image)

- **Ordered**
  - type 1
  - type a
  - type A
  - type I
  - type 1
- **Unordered**
  - type Circle
  - type Disc
  - type Square

---

**c.** The section numbering or bullet style will be changed to the selected type.

---

**Tips & Procedures for Complex Bulleted or Numbered Lists**

A good procedure for working with large, complex bulleted lists is as follows:

1. First, pick a single list type (an "Ordered" (numbered) list is a good choice). Create your list, separating your list items with *paragraphs* (created by pressing **Enter** on your keyboard).
2. Format ALL items that use list points using that single list type. So you have A, B, C, D, E, F, G, H, I, J.
3. Indent the parts of the list that need indenting using the "Indent" button on the Collage toolbar. So now you have, for example: A, B, C, 1, 2, 3, 4, H, I J.
4. Now highlight the indented areas that you wish to convert to bullets, select the "List" icon and change to "Unordered" (bulleted) list as necessary.
5. Go back and add "spaces" between list items as desired using *line breaks* (created by using **Shift + Enter** on your keyboard).

Using this process will keep you list items together correctly, and preserve your desired numbering.
Creating Tables in Collage

The Collage editing environment will enable you to create tables for **data** or **layout**:

1. **Data tables** are tables which contain grid-based information, such as a grid of names and phone numbers.
2. **Layout tables** are tables (typically with transparent borders) that enable more flexible positioning of content on a web page.

Example Table and Procedure

Let’s say we want to create a table in Collage that looks like this:

<table>
<thead>
<tr>
<th>Name</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pat Smith</td>
<td><a href="mailto:pat.smith@csuci.edu">pat.smith@csuci.edu</a></td>
</tr>
<tr>
<td>Tracy Robinson</td>
<td><a href="mailto:tracy.robinson@csuci.edu">tracy.robinson@csuci.edu</a></td>
</tr>
<tr>
<td>John Musmire</td>
<td><a href="mailto:john.musmire@csuci.edu">john.musmire@csuci.edu</a></td>
</tr>
</tbody>
</table>

1. Place the cursor in the “body text” field at the location where you would like to insert the table.

2. Next, click the “Table” icon on the editing toolbar.
3. Select “Insert/Edit Table” from the drop-down menu

4. A dialog box will appear that will allow you to set the parameters of your table.

5. First, enter the number of Columns and Rows the table should have in the “Columns” and “Rows” boxes.

6. Next, set the “Width” attribute of the table in pixels (e.g., 300px) or as a percentage (e.g., 75%) of content area width. Please note that the maximum width for a table in the current CSUCI template is 540px.
7. Set the **Border** attribute for your table
   a. Set “Border” to 1 for data tables or whenever you want a grid to be displayed
   b. Set “Border” to 0 make the border transparent
8. Set “Cell padding” and “Cell spacing” attributes
   a. *Cell padding* is the distance between the table cell wall and its contained text.
      Recommended value is **between 4 and 10**.
   b. *Cell spacing* is the distance between the table cell walls with one another.
      Recommended value is **0 or 1**.
9. Set the **align** option to **(none)**
10. Leave the **Background** field blank.
11. For data tables, you must include a written description of the table in the “Summary” field. This should be a short written description of the kinds of information people will find in the table.
12. Because our table has headings in the first row, check the checkmark next to “**Build first row using header cell tags**”. This will help address accessibility requirements per Section 508 (g) and (h) guidelines.
13. A blank table will appear as defined

Contact Us

Our contact information can be found in the table below:
14. Populate the table with the headings and the table data as shown.

<table>
<thead>
<tr>
<th>Name</th>
<th>Email Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pat Smith</td>
<td><a href="mailto:pat.smith@csuci.edu">pat.smith@csuci.edu</a></td>
</tr>
<tr>
<td>Tracy Robinson</td>
<td><a href="mailto:tracy.robinson@csuci.edu">tracy.robinson@csuci.edu</a></td>
</tr>
<tr>
<td>John Musmire</td>
<td><a href="mailto:john.musmire@csuci.edu">john.musmire@csuci.edu</a></td>
</tr>
</tbody>
</table>

15. Next set the scope of each of the table header cells.
   a. Put the cursor in the table header cell.
   b. Go to Table > Cell Settings…
   c. Set the “Scope” dropdown as needed. Column headings should be set to “Column”, row headings should be set to “Row”.

57
Changing Table Properties

1. To change the properties of a table, position your cursor within any table cell.
2. Choose the “Table” icon from the editing toolbar.
3. From the dropdown menu, choose the “Insert/Edit Table” option to change table width, cell spacing/padding, or borders.
4. You may also add or delete columns and rows, and merge cells using the options in the “Table” dropdown menu.
**Copying and Pasting from Microsoft Word into Collage**

The following process describes how to ensure proper formatting of content in Collage when copying content into Collage from a Microsoft Word document. It is not recommended to copy and paste directly from Word into Collage, as extraneous formatting will be applied to the Collage content, and it will become more difficult to edit.

**Option 1. Word > Notepad > Collage (recommended)**

Some items will require reformatting or re-creation in Collage after using this approach (such as headings, tables and lists).

1. Open the document in Microsoft Word.
2. Highlight the content that you wish to paste into Collage.
3. In Word, select the “Edit” menu, then “Copy”; or use the CTRL + C keyboard shortcut.
4. Open Windows Notepad (Windows Start menu > All Programs > Accessories > Notepad).
5. In Notepad, paste in the contents of the clipboard by selecting the “Edit” menu, then “Paste”; or use the CTRL + V keyboard shortcut.
6. Highlight all of the content in Notepad, or use the keyboard shortcut CTRL + A (Select All).
7. In Notepad, select the “Edit” menu, then “Copy”; or use the CTRL + C keyboard shortcut.
8. Open the Collage document that you wish to paste content into.
9. Position the cursor where you want your content to be pasted.
10. Press CTRL + V; or, you can right-click and choose “Paste” to paste the clipboard contents.
11. Clean up formatting in Collage as required.

**Option 2. Word > Dreamweaver > Collage**

This approach requires the use of Dreamweaver. It is more complex, but has better support of copying headings, tables, lists and other Word style formatting.

1. Open the document in Microsoft Word.
2. Highlight the content that you wish to paste into Collage.
3. In Word, select the “Edit” menu, then “Copy”; or use the CTRL + C keyboard shortcut.
4. Open Macromedia Dreamweaver (Windows Start menu > All Programs > Macromedia > Dreamweaver).
5. Create a new blank document (File > New).
6. In Dreamweaver, paste in the contents of the clipboard into the new document by selecting the “Edit” menu, then “Paste”; or use the CTRL + V keyboard shortcut.
7. Switch to the “Code” view in Dreamweaver to view the HTML source code.
8. Highlight all of the HTML source code between the `<body>` tags in Dreamweaver.
9. Right-click on the source code in Dreamweaver and select “Copy”.
10. Open the Collage document that you wish to paste content into.
11. Switch to the “Source” tab in your editing window.
12. In the “body” text area, position your cursor where you want your content to go.
13. Press CTRL + V to paste in the HTML source code.
14. Position the cursor where you want your content to be pasted.
15. Clean up formatting in Collage as required.
**Technical Support and Assistance**

Please contact the Help Desk at helpdesk@csuci.edu or call 805-437-8552 with any questions about or problems that you experience with Collage. A work order created for you, assigned to the appropriate technician, and you will receive email confirmation of the work order creation, including a reference number.

**Running Collage for the First Time**

To run Collage v5.1 on Windows, you must use the Sun Java Virtual Machine version 1.5.0 Update 11 through Update 22 for all functionality to work correctly. Java VM 1.6 is not supported. The correct Java VM can be downloaded for free from the “Downloads” section at http://www.csuci.edu/it/web/contentmanagement.htm. Please contact the Help Desk at helpdesk@csuci.edu for assistance configuring the Java Virtual Machine or Collage.

To run Collage v5.1 on Mac, please contact the Help Desk at helpdesk@csuci.edu for assistance with configuring your computer to run Collage. The recommended configuration is to use Windows XP on VMWare to access Collage.

For both Windows and Mac users of Collage:

Please must make sure that you are not running any other versions of Sun Java Virtual Machine on your computer. Likewise if you are running the Microsoft Virtual Machine, you should disable this in Internet Explorer.

Make sure that any popup blocking software allows popups from “collage.csuci.edu”.

During your first logon, you may be prompted by your browser to install other components. Click “Always” during any prompts to ensure the components are installed and that you will no longer be prompted to install components.